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[bookmark: _Toc51268793]Purpose
With Basic Bank Account Management, cash managers and bank accountants can centralize the management of bank accounts using bank account master data, a table view of banks and bank accounts.
Bank account master processing can also be handled by dual control or approval workflow, including:
1. Create a new bank account
· Change an existing bank account
· Close an obsolete bank account
This document provides a detailed procedure for testing this scope item after solution activation, reflecting the predefined scope of the solution. Each process step, report, or item is covered in its own section, providing the system interactions (test steps) in a table view. Steps that are not in scope of the process but are needed for testing are marked accordingly. Project-specific steps must be added.
[bookmark: unique_2][bookmark: _Toc51268794]Prerequisites
This section summarizes all the prerequisites for conducting the test in terms of systems, users, master data, organizational data, other test data and business conditions.
[bookmark: unique_3][bookmark: _Toc51268795]System Access
	System
	Details

	System
	Accessible via SAP Fiori launchpad. Your system administrator provides you with the URL to access the various apps assigned to your role.


[bookmark: unique_4][bookmark: _Toc51268796]Roles
Assign the following business roles to your individual test users. Alternatively, if available, you can create business roles using the following spaces with pages and predefined apps for the SAP Fiori launchpad and assign the business roles to your individual test users.
Note These roles or spaces are examples provided by SAP. You can use them as templates to create your own roles or spaces.
For more information about business roles, refer to Assigning business roles to a user in the Administration Guide to Implementation of SAP S/4HANA with SAP Best Practices .
	Name (Role)
	ID (Role)
	Description (Space)
	ID (Space)
	Log On

	Cash Management Specialist
	SAP_BR_CASH_SPECIALIST
	Cash Management
	SAP_BR_CASH_SPECIALIST
	

	General Ledger Accountant
	SAP_BR_GL_ACCOUNTANT
	General Ledger
	SAP_BR_GL_ACCOUNTANT
	

	Cash Manager
	SAP_BR_CASH_MANAGER
	Cash Management
	SAP_BR_CASH_MANAGER
	

	Configuration Expert
	SAP_BR_BPC_EXPERT
	
	
	


Note During testing, cash management specialist and configuration expert can share the same user ID, but cash manager and cash management specialist must be separate user IDs due to segregation of duty: cash management specialist creates the change request, cash manager approves it, the creator could not be the approver.
[bookmark: unique_5][bookmark: _Toc51268797]Master Data, Organizational Data, and Other Data
The organizational structure and master data of your company have been created in your system during activation. The organizational structure reflects the structure of your company. These master data represent materials, customers, and vendors, for example, depending on the operational focus of your company.
Note Additional Default Values
You can test the scope item with other SAP Best Practices default values that have the same characteristics. Review your SAP ECC system to find out which other material master data exists.
Use your own master data to go through the test procedure.
Caution The following Sample Values assume that you are only implementing one of the four Basic Account Master Data Procedures described in the Purpose  [page ] 1 section. If you are implementing and testing more than one, especially in a single environment, you cannot use the same Master Data values for more than one procedure types. You must create additional Master Data values, such as bank account numbers, bank keys, and so on, and then use these different values in each procedure type.
	Data
	Sample Value
	Details
	Comments

	BANK ACCOUNT NUMBER
	1133698
2580061
8765432188
	
	Bank account number

	BANK KEY
	50070010
82080000
88888886
	
	Bank key

	BANK NAME
	Bank 3
	
	Bank name

	G/L ACCOUNT
	11001000
11003000
	
	G/L account for bank account

	CHART OF ACCOUNTS
	YCOA
	
	Chart of accounts

	COMPANY CODE
	1010
	
	Company code

	HOUSE BANK
	DEBK1/DEAC1
DEBK2/DEAC2
	
	House bank

	HOUSE BANK ACCOUNT
	DEAC3
	
	House bank account

	HOUSE BANK ID
	DEBK3
	
	House bank ID

	SWIFT/BIC
	DEUTDEFFXX1
	
	SWIFT/BIC


For more information on creating these master data objects, see the following Master Data Scripts (MDS)
Table 1: Master Data Script Reference
	Master Data Script ID
	Description

	BNG
	Create G/L Account and Cost Element


Note Using Your Own Master Data
You can also use customized values for any material or organizational data for which you have created master data. For more information about creating master data, see the Master Data Procedures documentation.
[bookmark: unique_6][bookmark: _Toc51268798]Preliminary Steps
For Basic Bank Account Management, the following sections should be completed before testing the procedures.
[bookmark: unique_7][bookmark: _Toc51268799]G/L Account Created for Bank Account
A general ledger (G/L) account is a chronological accounting record used to track financial transaction. The G/L account is a structure that records value movements in a company. As a prerequisite, you must have already created a G/L account 11001000.
Caution Instructions provided assume that you are only implementing one of the four Bank Account Master Data Procedures described in the Purpose  [page ] 1 section. If you are implementing and testing more than one procedure, especially in a single environment, you cannot use the same Master Data values for more than one procedure type. You must have additional Master Data values created, for example G/L account numbers, bank keys, and so on, and then use these different values in each procedure.
[bookmark: unique_8][bookmark: _Toc51268800]Define Basic Settings
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Context
Within this Basic Bank Account Management scope item, the following four Bank Account Master Data Procedures are documented:
1. Bank Account Master Data Processing with Basic Cash Management and Direct Revision Activate
1. Bank Account Master Data Processing with Full Cash Management and Direct Revision Activate
2. Bank Account Master Data Processing with Full Cash Management and Dual Control Revision Activate
3. Bank Account Master Data Processing with Full Cash Management and Workflow Revision Activate
Caution The Bank Account Master Data Processing with Full Cash Management versions including Direct Revision Activate, Dual Control Revision Activate and Workflow Revision Activate, require an additional license for SAP Cash Management powered by SAP HANA.
In this preliminary step, you choose which one of these four Bank Account Master Data Processing Procedures to use for your implementation:
1. To use , use the following settings:
· Cash Management Scope = 01
· Basic Scope & Bank Account Revision = 01 Activate Directly
5. To use , use the following settings:
· Cash Management Scope = 02
· Full Scope & Bank Account Revision = 01 Activate Directly
6. To use , use the following settings:
· Cash Management Scope = 02
· Full Scope & Bank Account Revision = 02 Activate via Dual Control
7. To use , use the following settings:
· Cash Management Scope = 02
· Full Scope & Bank Account Revision = 03 Activate via Workflow
The check box Enable Snapshot is used for the snapshot of historic cash report. This check box can only be selected and saved when cash value is Full Scope. If the value of cash scope is Basic Scope, it can’t be saved once the check box of Enable Snapshot is selected. Once the check box of Enable Snapshot is selected and saved, the function of snapshot of historic cash report is activated.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log on
	Log on to the SAP Gui System as a Configuration Expert - Business Process Configuration.
	The SAP Gui System displays
	

	2
	Enter Transaction Code
	Enter Transaction Code SPRO in Command Bar.
	The Customizing: Execute Project screen displays.
	

	3
	Open SAP Reference IMG
	Open SAP Reference IMG
	
	

	4
	Define Basic Settings
	Choose the following navigation option:
Financial Supply Chain Management > Cash and Liquidity Management > General Settings > Define Basic Settings .
Verify your choices for Cash Management Scope and Bank Account Revision for your implementation based on the previously described procedures.
	The Define Basic Settings screen displays.
	



The check box Enable Snapshot is used for the snapshot of historic cash report. This check box can only be selected and saved when cash value is Full Scope. If the value of cash scope is Basic Scope, it can’t be saved once the check box of Enable Snapshot is selected. Once the check box of Enable Snapshot is selected and saved, the function of snapshot of historic cash report is activated.
Remember Define Basic Settings must be reviewed following any system upgrade or improvement before continuing any business operation in the system. When differences are found from previous activations, you must correct the setting through the following IMG path: IMG > Financial Supply Chain Management > Cash and Liquidity Management > General Settings > Define Basic Settings via the user who has sufficient authorization to do the customizing.
[bookmark: unique_9][bookmark: _Toc51268801]Define Account Type (Optional)
Purpose
This activity describes the approach to define account type.
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log on
	Log on to the SAP Gui System as a Configuration Expert - Business Process Configuration.
	The SAP Gui System displays
	

	2
	Enter Transaction Code
	Enter Transaction Code SPRO in Command Bar.
	The Customizing: Execute Project screen displays.
	

	3
	Open SAP Reference IMG
	Open SAP Reference IMG
	
	

	4
	Access Customizing Path
	Choose the following navigation option:
Financial Supply Chain Management > Cash and Liquidity Management > Bank Account Management > Basic Settings > Define Settings for Bank Account Master Data
	
	

	5
	Maintain Account Type Definition
	Choose Account Type Definition.
Choose New Entries.
Make the following entries and choose Save:
Type: 01
Account Type Description: Current Account
Attribute: 01 Operating Account
	
	


[bookmark: unique_10][bookmark: _Toc51268802]Change Message Control (Optional)
Purpose
In general, bank account with multiple house bank accounts and the different company code between bank account and house bank account are forbidden and error message is raised when saving the bank account. But in some special case, if you want to maintain multiple house bank accounts or different company code between bank account and house bank account, you can follow this instructions to customize the message from error to warning.

	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log on
	Log on to the SAP Fiori launchpad as a Configuration Expert - Business Process Configuration.
	
	

	2
	Enter Transaction Code
	Enter Transaction Code SPRO in Command Bar.
	The Customizing: Execute Project screen displays.
	

	3
	Open SAP Reference IMG
	Open SAP Reference IMG
	
	

	4
	Access Customizing Path
	Choose the following navigation option:
Financial Supply Chain Management > Cash and Liquidity Management > Bank Account Management > Basic Settings > Change Message Control .
	The Change Message Control screen displays.
	

	5
	Work Area
	Enter FCLM_BAM_MAINT in the Application Area field, then press Continue.
	The Change View “Message Control by User”: Overview screen displays.
	

	6
	Change Message Status for multiple house bank accounts
	Make the following entries:
MsgNo: 537
Message Text: You are linking the bank account to more than one house bank account.
User Name: (Blank)
*Online: W
*Batch Input: W
Standard: E
	
	

	7
	Change Message Status for different company code between bank account and house bank account
	Make the following entries:
MsgNo: 466
Message Text: You are linking the bank account to more than one house bank account.
User Name: (Blank)
*Online: W
*Batch Input: W
Standard: E
	
	

	8
	Save
	Save it.
	
	


[bookmark: unique_11][bookmark: _Toc51268803]Overview Table
The Basic Bank Account Management (BFA) scope item consists of process steps in the table below, depending upon the which of the four procedures you will implement.
If your system administrator has enabled spaces and pages on the SAP Fiori launchpad, the homepage will only contain the essential apps for performing the typical tasks of a business role.
You can find all other apps not included on the homepage using the search bar.
If you want to personalize the homepage and include the hidden apps, navigate to your user profile and choose Settings > App Finder .
Caution Instructions provided assume that you are only implementing one of the four Bank Account Master Data Procedures. If you are implementing and testing more than one procedure, especially in a single environment, you cannot use the same Master Data values for more than one procedure type. You must have additional Master Data values created, for example bank account numbers, bank keys, and so on, and then use these different values in each procedure.
Bank Account Master Data Processing With Basic Cash Management and Direct Revision Activate
Table 2:
	Process Step, Report or Item
	Business Role
	App/Transaction
	Expected Results

	Using Direct Revision Activate

	Create Bank Account

	Open Bank Account  [page ] 14
	Cash Management Specialist
	
	The bank accountant goes to the bank and opens a new bank account in this bank. This step does not occur in the system.

	Manage Banks  [page ] 15
	Cash Management Specialist
	Manage Banks - Basic (F1574)
	A bank key that does not exist in production system is created. If the bank key already exists, skip this step.

	Create Bank G/L Account   [page ] 16
	General Ledger Accountant
	Manage G/L Account Master Data (F0731A)
	FIN master data key user may create the G/L accounts of newly created bank account.

	Manage House Banks   [page ] 17
	Cash Management Specialist
	Manage Banks (F1574)
	The bank accountant creates the house bank. If a new bank account is opened in an existing house bank in your system, skip this step.

	Create Bank Account  [page ] 18
	Cash Management Specialist
	Manage Bank Accounts (F1366A)
	A new bank account that does not exist in production system is created.

	Export Bank Accounts  [page ] 21
	Cash Management Specialist
	Manage Bank Accounts (F1366A)
	Bank accounts are exported from production system.

	Import Bank Accounts  [page ] 23
	Cash Management Specialist
	Manage Bank Accounts (F1366A)
	Bank accounts are imported into development system and consolidation system.

	Change Bank Account

	Notify Bank to Change  [page ] 25
	Cash Management Specialist
	
	The bank accountant goes to the bank and asks the bank employee to change the attributes of this bank account. This step does not occur in the system.

	Update Bank G/L Account  [page ] 25
	General Ledger Accountant
	Manage G/L Account Master Data (F0731A)
	FIN master data key user updates the G/L account of bank only when it is necessary. However, modification of bank account does not result in G/L account modification every time.

	Change Bank Account  [page ] 26
	Cash Management Specialist
	Manage Bank Accounts (F1366A)
	The bank accountant changes the attributes of this bank account in system.

	Export Bank Accounts  [page ] 28
	Cash Management Specialist
	Manage Bank Accounts (F1366A)
	After bank account’s attribute is changed, and therefore it is necessary to export the bank accounts from production system.

	Import Bank Accounts  [page ] 30
	Cash Management Specialist
	Manage Bank Accounts (F1366A)
	Bank accounts are imported into development system and consolidation system.

	Close Bank Account

	Notify Bank to Close Account  [page ] 32
	Cash Management Specialist
	
	The bank accountant goes to the bank and asks the bank employee to close this bank account. This step does not occur in the system.

	Close Bank Account and Cancel Closing  [page ] 32
	Cash Management Specialist
	Manage Bank Accounts (F1366A)
	The redundant bank account is closed in system.

	Remove Inconsistent Data after Closing a Bank Account (Optional)  [page ] 35
	Configuration Expert
	Manage Your Solution (F1241)
	The inconsistent data is checked and removed.

	GL Account Reduction and Migration (Optional)  [page ] 36
	Cash Management Specialist
	Manage Bank Accounts (F1366A)
	GL Accounts are reduced and migrated.

	Import Bank Data  [page ] 38
	Cash Management Specialist
	Transfer BIC Data (BIC2)
	The bank data is imported.

	Fields Enhancement for Bank Account Master Data  [page ] 40
	Administrator
	Custom Fields and Logic (F1481)
	Fields are added.



Table 3: Maintain Bank Chain
	Process Step, Report or Item
	Business Role
	App/Transaction
	Expected Results

	Create Bank Chain  [page ] 43
	Accounts Payable Accountant
	Manage Bank Chains (F4004)
	Bank chain created.

	Change Bank Chain  [page ] 44
	Accounts Payable Accountant
	Manage Bank Chains (F4004)
	Bank chain changed.

	Delete Bank Chain  [page ] 45
	Accounts Payable Accountant
	Manage Bank Chains (F4004)
	Bank chain deleted.

	Check Bank Chain Information In Business Partner (Optional)  [page ] 46
	Accounts Payable Accountant.
	Maintain Business Partner (BP)
	Bank chain information checked in business partner.

	Schedule Delete Bank Chain Jobs  [page ] 48
	Accounts Payable Accountant.
	Maintain Business Partner (BP)
	Bank chain information checked in business partner.


[bookmark: unique_35][bookmark: _Toc51268804]Test Procedures
These sections describe the test procedures for each process step that belongs to this scope item.
Follow the procedures in the Bank Account Master Data Processing With Basic Cash Management and Direct Revision Activate section when you use Basic Cash Management without an additional license for SAP Cash Management powered by SAP HANA.
When you have Full Cash Management, which requires an additional license for SAP Cash Management powered by SAP HANA, follow the procedures that apply to your implementation: Bank Account Master Data Processing With Full Cash Management and Direct Revision Activate, or Bank Account Master Data Processing With Full Cash Management and Dual Control Revision Activate, or Bank Account Master Data Processing With Full Cash Management and Workflow Revision Activate.
Caution Instructions provided assume that you are only implementing one of the four Bank Account Master Data Procedures described in the Purpose  [page ] 1 section. If you are implementing and testing more than one procedure, especially in a single environment, you cannot use the same Master Data values for more than one procedure type. You must have additional Master Data values created, such as bank account numbers, bank keys, and so on, and then use these different values in each procedure.
[bookmark: d2e1381][bookmark: _Toc51268805]Bank Account Master Data Processing With Basic Cash Management
[bookmark: d2e1382][bookmark: _Toc51268806]Using Direct Revision Activate
[bookmark: d2e1383][bookmark: _Toc51268807]Create Bank Account
[bookmark: unique_12][bookmark: _Toc51268808]Open Bank Account
Purpose
The bank accountant (Cash Management Specialist) goes to the bank and opens a new bank account in this bank. This step does not occur in the system.
[bookmark: unique_13][bookmark: _Toc51268809]Manage Banks
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
The purpose of this step is to create a bank key that does not exist in production system.
Note If the bank key already exists, skip this step.
Note The bank key is created in the production system, development system, and consolidation test system.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log on
	Log on to the SAP Fiori launchpad as a Cash Management Specialist.
	
	

	2
	Access the SAP Fiori app
	Open Manage Banks (F1574).
	
	

	3
	Choose Create Bank
	Choose Go for the banks to display in a list and choose Create Bank.
	The Create Bank view displays.
	

	4
	Enter Criteria
	Make the following entries:
Bank Country: DE
Bank Key: 88888886
Bank Name: Bank 3
SWIFT/BIC: DEUTDEFFXX1
Bank Category: External - Standard
Note Internal - Payment Service Provider and External - Standard can be selected in the Bank Category field. If the bank key created is used for a normal physical bank account, please select External - Standard. If the bank key created is used for an internal virtual account, for example PayPal, please select Internal - Payment Service Provider.
City: for example, 60040 Frankfurt, Main
	The Create Bank: Detail view displays.
	

	5
	Save
	Choose Save.
	A new bank key is created.
	


[bookmark: unique_14][bookmark: _Toc51268810]Create Bank G/L Account
Purpose
The General Ledger Accountant may create the G/L accounts for a new bank account.
Note For cash management in this package, you can use the same G/L accounts (bank main account and bank subaccount) for different bank accounts when they use the same currency key. The balance of each bank account can be displayed in the cash management app, instead of checking balances of the relevant G/L account. Using this approach keeps the chart of accounts smaller.
Note If you want to create a new G/L account for a new bank account, execute the following steps. Create the G/L accounts in production system, development system, and consolidation test system.
Note This procedure is mentioned in the Accounting and Financial Close (J58) test script. You can refer to the Manage G/L Account Master Data step and copy an existing G/L account to a new one (for example, copy 11001000 to 11003000).
[bookmark: unique_15][bookmark: _Toc51268811]Manage House Banks
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
The key user creates the house bank.
Note If you opened a new bank account in an existing house bank in your system, skip this step.
Note Perform this step in the development system, consolidation test system, and production system since house banks are master data in the SAP S/4HANA system.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log on
	Log on to the SAP Fiori launchpad as a Cash Management Specialist.
	
	

	2
	Access the SAP Fiori App
	Open Manage Banks (F1574).
	
	

	3
	Choose Bank Key
	Make the following entries:
1. Bank Country: DE
· Bank Key: <your Bank Key number created in the step Manage Banks>
If the Bank Key field is not visible, choose Filters to unhide it.
Choose Go.
	The Display Bank view appears.
	

	4
	Edit Bank Key
	Choose Bank Name to display the bank, and then choose Edit.
Choose add in the House Banks area.
	TheManage Banks view displays.
	

	5
	Create House Bank
	Make the following entries:
1. Company Code: 1010
· House Bank: DEBK3
· Customer Number: 10100003
· Company Number: <designated company number>, for example, 1010
	
	

	6
	Save
	Choose Save.
	New house bank is saved successfully.
	


[bookmark: unique_16][bookmark: _Toc51268812]Create Bank Account
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
This step describes how to create a new bank account by a bank accountant (Cash Management Specialist).
Note Please note that the bank account must be created manually in the Production system, because this kind of master data can not be transport from the Q system to the P system.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log on
	Log on to the SAP Fiori launchpad as a Cash Management Specialist.
	
	

	2
	Access the SAP Fiori app
	Open Manage Bank Accounts (F1366A).
	The Manage Bank Account view displays.
	

	3
	Add Bank Account
	Choose Create New Bank Account + to add a new bank account.
	The Bank Account view displays.
	

	4
	Enter Header Data
	Make the following entries:
Account Number: 8765432188
Account Description: DEBK3
Bank Country: DE
Bank Key: 88888886
Note To maintain the bank key in this step, the bank key must already exist in the system.
Account Currency: EUR
	
	

	5
	Enter General Data
	Change the following entries:
Opening Date: for example, <current date>
Company Code: 1010
Account Holder: for example, Company Code 1010 (company code name is usually defaulted by system)
Account Type: for example, 01 Current Account
IBAN: <Generate IBAN>
Note Only perform this step if the country is using IBAN; if you do not use IBAN in your process, just skip this step.
Bank Control Key: for example, P
Note Only perform this step if the country is using Bank Control Key; if you do not use Bank Control Key in your process, just skip this step.
	
	

	6
	Generate IBAN
	Note Only perform this step if this country is using IBAN. If you do not use IBAN in your process, you can skip this step.
Choose IBAN.
When the warning dialog box appears, choose OK.
The proposed IBAN is automatically entered.
	
	

	7
	Maintain Internal Contact Persons (Contact Person)
	In the Internal Contact Persons area:
Enter a system user ID, such as the ID assigned with the Cash Management Specialist business role.
Enter the ID in the Contact Person field.
	
	

	8
	Maintain Internal Contact Persons (Bank Account Supervisor)
	In the Internal Contact Persons area:
Enter a system user ID, for example, the ID assigned with the Cash Manager business role.
Enter the user ID in the Bank Account Supervisor field.
	
	

	9
	Choose House Bank Account Connectivity
	Choose House Bank Account Connectivity.
	The Connectivity Path tab appears.
	

	10
	Enter Connectivity Criteria
	Choose Create, and make the following entries:
ID Category: for example, Central System: House Bank Account
Remote System: <leave blank>
Company Code: 1010
House Bank: DEBK3
House Bank Acct ID: DEAC3
G/L Account: 11003000
Choose Apply.
	
	

	11
	Save and activate bank account
	Ensure all necessary data have been entered and choose Save as Inactive.
Choose Activate.
	A new bank account is created.
	

	12
	Review History and Revision
	Select the newly created bank account, and on the Bank Account view, the new bank account is active in the display mode. No revision button exists.
Choose Account Histories and a history dialog box displays with the history list of the current bank account: Revision 1, activated.
	
	


[bookmark: unique_17][bookmark: _Toc51268813]Export Bank Accounts
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
The new bank account (including house bank account) creation in production system is completed in the previous procedure. Some system configuration is based on the house bank and the house bank account. Because configuration is done in the development system, you must export the bank accounts from that system to the development and consolidation test system.
Prerequisites
1. You use Microsoft Office 2010 or higher that contains Microsoft Excel.
· The Developer tab in Microsoft Excel is enabled.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log on
	Log on to the SAP Fiori launchpad as a Cash Management Specialist.
	
	

	2
	Access the SAP Fiori App
	Open Manage Bank Accounts (F1366A).
	The Manage Bank Accounts view displays.
	

	3
	Import and Export Accounts
	Choose Import and Export Bank Accounts.
	The Import and Export Bank Accounts view displays.
	

	4
	Export Data
	In the Bank Accounts Export section, choose Export Bank Accounts to an XML File.
In the File Download dialog box, choose Save As.
In the Save As dialog box, identify a location to save the XML file.
Choose Save.
Download processing steps varies on different browser, above steps apply to IE. If you are using Chrome, the file will be directly saved in C:\Users\[your user ID]\Downloads
	The Bank_Accounts.xml file saved to the location you indicated.
The file contains all the existing bank account master data in your system in XML format.
	

	5
	Download the Spreadsheet Template
	In the Bank Accounts Export section, choose Download XML Spreadsheet Template.
In the File Download dialog box, choose Save As
In the Save As dialog box, identify a location to save the XML spreadsheet template.
Choose Save.
Download processing steps varies on different browser, above steps apply to IE. If you are using Chrome, the file will be directly saved in C:\Users\[your user ID]\Downloads
	The XML_Spreadsheet_Template.xml file is saved to the location you indicated
	

	6
	Import
	Use Microsoft Excel to open XML_Spreadsheet_Template.xml.
Using the Developer tab in Excel, choose Import, and then choose the Bank_Accounts.xml file in the Import XML dialog box and Import.
	Bank accounts master data has been imported into the XML spreadsheet template.
If message XML import error - Failed schema validation displays, but data has been imported from Bank_Accounts.xml, ignore this message by choosing OK.
	

	7
	Export Data to a New File
	From the Developer tab in Microsoft Excel, choose Export, and enter the file name Bank_Accounts_Export.xml.
Choose Export.
	Bank accounts master data has been saved in the Bank_Account_Export.xml file.
	


[bookmark: unique_18][bookmark: _Toc51268814]Import Bank Accounts
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
Import the exported bank accounts into the development system and consolidation test system.
Note You may only have one client for testing. You can test the function Export and Import the bank accounts in the same client.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log on
	Log on to the SAP Fiori launchpad as a Cash Management Specialist.
	
	

	2
	Access the SAP Fiori app
	Open Manage Bank Accounts (F1366A).
	The Manage Bank Accounts view displays.
	

	3
	Import and Export Accounts
	Choose Import and Export Bank Accounts.
	The Import and Export Bank Accounts view displays.
	

	4
	Identify the Import Path
	Choose Select File.
On the Open dialog box, identify the XML (Bank_Accounts_Export.xml) to be uploaded.
Choose Open.
	
	

	5
	Import with Test Run
	Choose Import with Test Run, and verify the validation results.
If the Bank Account "XXXXXXXXXX" is already in approval process notification displays, we recommend that you import the bank accounts at a different time, since those bank accounts are in process workflow.
When the message displays, only execute a test run, or complete the workflow, before the production run.
When the status of all validation results is OK, you can import bank accounts into production system.
	
	

	6
	Import with Production Run
	Choose Select File again.
In the Open dialog box, identify the XML (Bank_Accounts.xml) to be uploaded
Choose Open.
Choose Import and check the validation results.
	Bank accounts are successfully imported into development system.
	

	7
	Import to Test System
	Repeat the preceding steps to import bank accounts into consolidation test system.
	
	


[bookmark: d2e2070][bookmark: _Toc51268815]Change Bank Account
[bookmark: unique_19][bookmark: _Toc51268816]Notify Bank to Change
Procedure
The bank accountant (Cash Management Specialist) goes to the bank and asks the bank employee to change the attributes of this bank account. This step does not occur in the system.
Note Bank account master data modification does not always result in a notification to the bank (for example, the modification of payment signatories).
[bookmark: unique_20][bookmark: _Toc51268817]Update Bank G/L Account
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
The key user updates the G/L account of the bank only when updating is required. For example, if the currency key of the bank account is changed, the user updates the currency of the G/L account. Not all bank account modifications result in a G/L account modification.
Note Update the G/L accounts in the production, development, and consolidation test systems.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log on
	Log on to the SAP Gui System.
	
	

	2
	Enter Transaction Code
	Enter Transaction Code FS00 in Command Bar.
	
	

	3
	Choose the G/L Account
	Make the following entries and choose Change:
G/L Account: For example, 11003000
Company Code: For example, 1010
	
	

	4
	Maintain the attributes of the G/L account at Company Code Level
	Update the attributes of the account.
For example, change Account Currency to a different currency from the one you used when creating a bank account in the previous step Create Bank Account Change Request, and deselect the checkbox of Balances in Local Currency Only.
	
	

	5
	Save the G/L Account
	Choose Save.
	The G/L account is updated successfully.
	

	6
	Update Bank Subaccount
	Repeat the preceding steps to change bank subaccounts.
For example, from 11003010 to 11003099.
	Relevant bank subaccounts are updated.
	



Note Changing the currency is not possible when there is an existing balance for the G/L account.
[bookmark: unique_21][bookmark: _Toc51268818]Change Bank Account
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
This step describes how to change a bank account by bank accountant (Cash Management Specialist).
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log on to the SAP Fiori launchpad as a Cash Management Specialist.
	
	

	2
	Access the SAP Fiori App
	Open Manage Bank Accounts (F1366A).
	The Manage Bank Accounts (F1366A) view displays.
	

	3
	Choose Account to Change
	Choose the bank account to be changed from the account list view.
For example, account 8765432188 in DEBK3.
Enter the filter and choose Go.
	A new view displays.
	

	4
	Edit
	Choose Edit. Modify fields according to your requirements.
	
	

	5
	Save
	Choose Save to save the changes.
	The bank account changes (updated) and a warning notification displays about bank statements.
	


[bookmark: unique_22][bookmark: _Toc51268819]Export Bank Accounts
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
You completed the bank account modification in the production system in the previous step. Some system configuration is based on house bank and house bank account, so after a bank account’s attribute is changed, configuration may be required to update the development system. If an update is required, you must export the bank accounts from the production system, and then import them into the development and consolidation test systems.
Prerequisites
Use Microsoft Office 2010 or higher that contains Microsoft Excel.
Enable the Developer tab in Microsoft Excel.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log onto the SAP Fiori launchpad as a Cash Management Specialist.
	
	

	2
	Access the SAP Fiori App
	Open Manage Bank Accounts (F1366A).
	The Manage Bank Accounts (F1366A) view displays.
	

	3
	Select View
	Choose Import and Export Bank Accounts.
	The Import and Export Bank Accounts view displays.
	

	4
	Export Accounts File
	In the Bank Accounts Export section, choose Export Bank Accounts to an XML File.
On the File Download dialog box, choose Save.
On the Save As dialog box, identify a location to save the XML file.
Choose Save.
	The Bank_Accounts.xml file is saved at the location you indicated.
	

	5
	Download Spreadsheet
	In the Bank Accounts Export section, choose Download XML Spreadsheet Template.
On the Save As dialog box, identify a location to save the XML spreadsheet template.
Choose Save.
	The XML_Spreadsheet_Template.xml file is saved at the location you indicated.
	

	6
	Import Data
	Open the XML_Spreadsheet_Template.xml in Excel. On the Developer tab, choose Import.
Choose the Bank_Accounts.xml file in the Import XML dialog box.
Choose Import.
	Bank accounts master data has been imported into the XML spreadsheet template.
If the XML import error-Failed schema validation notification displays, but data has been imported from Bank_Accounts.xml, ignore this message and choose OK.
	

	7
	Export Data to a New XML File
	From the Developer tab in Microsoft Excel, choose Export.
Enter the file name Bank_Accounts_Export.xml.
Choose Export.
	Bank accounts master data has been saved in Bank_Accounts_Export.xml.
	


[bookmark: unique_23][bookmark: _Toc51268820]Import Bank Accounts
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
Import the exported bank accounts into the development system and consolidation test system.
Note If you only have one client for testing, you can export and import the bank accounts in the same client.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log on to the SAP Fiori launchpad as a Cash Management Specialist.
	
	

	2
	Access the SAP Fiori App
	Open Manage Bank Accounts (F1366A).
	
	

	3
	Select View
	Choose Account list.
Choose Import and Export Bank Accounts.
	The Import and Export Bank Accounts view displays.
	

	4
	Identify the Import Path
	Choose Select File.
	The Open dialog box displays.
	

	5
	Identify the Import Path
	Identify the XML (Bank_Accounts_Export.xml) to be uploaded and choose Open.
	
	

	6
	Import with Test Run
	Choose Import with Test Run, and verify the validation results.
If the system displays a Bank Account "XXXXXXXXXX" is already in approval process notification, we recommend only executing a test run, since some bank accounts are still in process in the workflow. When the notification displays, only execute a test run or complete the workflow before the production run.
When the status of all validation results is OK, you can import bank accounts into the production system.
	
	

	7
	Import with Production Run
	Choose Choose File again.
	The Open dialog box displays.
	

	8
	Import with Production Run
	Identify the XML (Bank_Accounts_Export .xml) to be uploaded and choose Open.
	
	

	9
	Import with Production Run
	Choose Import. Verify the validation results.
	Bank accounts are successfully imported into the development system.
	

	10
	Import to Test System
	Repeat the preceding steps to import bank accounts into the consolidation test system.
	
	


[bookmark: d2e2561][bookmark: _Toc51268821]Close Bank Account and Cancel Closing
[bookmark: unique_24][bookmark: _Toc51268822]Notify Bank to Close Account
Procedure
The bank accountant (Cash Management Specialist) goes to the bank and asks the bank employee to close the bank account. This step does not occur in the system.
[bookmark: unique_25][bookmark: _Toc51268823]Close Bank Account and Cancel Closing
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
This step describes how to close an obsolete bank account by bank accountant (Cash Management Specialist) and the process of cancel the closing if you want to reactivate it.
Prerequisite
There are five indicators to display the status of a bank account.

	Status
	Comment

	Active
	This status indicates bank account is successfully created in sap system and can be normally used.

	Inactive
	This status displayed in full cash management, it indicates bank account is initially created without being approved.

	Closing Request Sent to Bank
	This status indicates you have planned and informed the bank to close the bank account in a future date. After initial closing button is triggered and approved, the bank account status will be display as Closing Request Sent to Bank. The function of bank account in status Closing Request Sent to Bank is the same with bank account status active, for example, you can still normally use it as review bank account, make bank transfer, run payment, posting etc.

	Closed at Bank
	This status indicates the bank account has been closed by the bank. You can’t make bank transfer, run payment, review bank account, maintain payment approver, import signatory cards, monitor intraday/end of day bank statement and being displayed in bank relationship overview in this status. But posting is still allowed in Closed at Bank.

	Closed
	This status indicates the bank account is completely closed in sap system, posting is also banned when comparing with status Closed at Bank.



Caution Don't close sample bank accounts that are connected to house bank DEBK1/DEAC1 and DEBK2/DEAC2 in the Connectivity Path tab for the bank master data (bank account 1133698 of bank key 50070010, and bank account 2580061 of bank key 82080000). The sample bank accounts are used when testing other scope items, for example, Accounts Payable (J60) and Advanced Cash Operations (J78).
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log on
	Log on to the SAP Fiori launchpad as a Cash Management Specialist.
	
	

	2
	Access the SAP Fiori app
	Open Manage Bank Accounts (F1366A).
	
	

	3
	Choose the Bank Account to Close
	Choose the triangle button of the bank account to be closed
For example, account 8765432188 in DEBK3.
If you are testing or implementing more than one option within the same client environment, for example, Basic Cash Management and Full Cash Management, you must use different bank account numbers for each of the four options.
	
	

	4
	Bank Account Initial Closing
	Choose Send Closing Request to Bank.
	The Initiate Closing dialog box is displayed.
	

	5
	Start to Initial Closing
	Make the following entries in the dialog box and choose Send Closing Request to Bank:
Planned Closing Date: for example, <current date>+2days
Choose OK in the success dialog box.
	The bank account’s status is changed to Closing Request Sent to Bank.
	

	6
	Confirm Closing at Bank
	Choose Confirm Closing at Bank.
	The Confirm Closing at Bank dialog box is displayed.
	

	7
	Start to Confirm Closing at Bank
	Make the following entries in the dialog box and choose Confirm Closing at Bank.
Closing Date: for example, <current date>
	The bank account’s status is changed to Closed at Bank.
	You can choose confirm closing at bank without bank account initial closing. If you bypassing the initial closing procedure and choose confirm closing at bank, the bank account status will be changed to Closed at Bank directly.

	8
	Complete Closing
	Choose Complete Closing.
	The Complete Closing dialog box is displayed.
	

	9
	Start to Confirm Closing at Bank
	Choose Close in the Complete Closing dialog box.
	The bank account’s status is changed to Closed.
	

	10
	Initiate Reopening
	Choose Initiate Reopening.
	The bank account’s status is changed to Closed at Bank.
	

	11
	Reopen at Bank
	Choose Reopen at Bank.
	The bank account’s status is changed to Closing Request Sent to Bank.
	

	12
	Revert to Active
	Choose Revert to Active.
	The bank account’s status is changed to Active.
	You can choose Revert to Active directly in bank account status Close at Bank, after which bank account status will be changed to Active.


[bookmark: unique_26][bookmark: _Toc51268824]Remove Inconsistent Data after Closing a Bank Account (Optional)
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
There might be some inconsistent data for a closed bank account. These data includes, bank determination data for payment, account determination data for bank transfer, Clearing account for receiving banks and the remaining house bank account data in G/L account, which can cause inconsistent check error. You can fulfill this step to check and remove the inconsistent data.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log on
	Log onto the SAP Gui system.
	
	

	2
	Access Bank Determination Customizing
	Enter Transaction Code FBZP.
Choose Bank Determination.
	
	

	3
	Remove Bank Determination Data
	Select the check box of the company code that the closed bank account belongs to.
Choose Bank Accounts Tab.
Select the check box of the inconsistent bank determination data.
Choose Delete.
Choose Save.
	
	

	4
	Access Account Determination Customizing
	Open Transaction Code SPRO on the command bar.
Open SAP Reference IMG.
Choose the following navigation option:
Financial Accounting > Bank Accounting > Business Transactions > Payment Transactions > Payment Handling > Bank Clearing Account Determination > Define Account Determination
	
	

	5
	Remove Account Determination Data
	Input the company code that the closed bank account belongs to.
Choose Enter.
Select the check box of the inconsistent account determination data.
Choose Delete.
Choose Save.
	
	

	6
	Access Define Clearing Accts for Receiving Bank for Acct. Transfer
	Open Transaction Code SPRO on the command bar.
Open SAP Reference IMG
Choose the following navigation option:
Financial Accounting > Bank Accounting > Business Transactions > Payment Transactions > Payment Request > Define Clearing Accts for Receiving Bank for Acct. Transfer
	
	

	7
	Remove Receiving Bank’s Clearing Account
	Select the check box of the inconsistent clearing account data.
Choose Delete.
Choose Save.
	
	


[bookmark: unique_27][bookmark: _Toc51268825]GL Account Reduction and Migration (Optional)
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
You can reduce your GL account by using the reconciliation account and migrate your old GL account data to it.
The following section is ONLY relevant for the on-premise version of SAP S/4HANA. Cloud version of SAP S/4HANA support G/L reduction, but not G/L migration. If you want to do G/L reduction on the cloud, you can replace the house bank account connectivity with a new bank reconciliation account.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log on
	Log on to the SAP Fiori launchpad as a Cash Management Specialist.
	
	

	2
	Access the SAP Fiori App
	Open Manage Bank Accounts (F1366A).
	
	

	3
	Choose the Bank Account to Change
	Choose the bank account to be changed from the account list view.
For example, account 1133698 in DEBK1.
Enter the filter and choose Go.
	A new window displays.
	

	4
	Start to Edit
	Choose the triangle button of account 1133698.
Choose Edit.
Choose the triangle button of the connectivity path.
	House Bank Account Connectivity screen displays.
	

	5
	Reduce and Migrate G/L Account
	Choose Migrate G/L Account, and the Target Bank Reconciliation Account field displays.
Choose the target bank reconciliation account through search help.
If no old GL account exist, or you don’t have to migrate the data, you don’t have to use Migrate G/L Account button.
Choose Apply.
	
	

	6
	SAVE
	Choose Save.
	The bank account is changed (updated).
	


[bookmark: unique_28][bookmark: _Toc51268826]Import Bank Data
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
In this activity, you import bank master data into the SAP S/4HANA system.
Prerequisites
Download a copy of the linked bank data template file. You can also get it from the SWIFT website.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log on
	Log on to the SAP GUI.
	
	

	2
	Access the SAP Fiori app
	Execute transaction BIC2S.
	
	

	3
	Import Bank Data
	In the Open dialog box, browse to the location of the bank data text file, and choose Open.
	
	

	4
	Enter Data
	Make the following entries and choose Execute:
File Structure: Bank Directory SAP (swiftrefdata.com), BDE
Bank Country: <bank country>, for example, DE
Test Run: Select (for test run), or Deselect (for actual run)
1. The Bank country selection option restricts the quantity of data imported from the file to the countries that you specify. For example you can use this to split the countries into groups for processing in multiple program runs with different import parameters. If you do not specify a country, the system processes all the data records from the file whose ISO country code matches the two-character ISO country code of a country set up in the SAP system.
· Test Run checkbox: If you select this checkbox, the system does not update the data in the database when you execute the report. In a test run, the system processes the data and displays the planned changes in a list. The database is not updated.
· Delta Upload checkbox: If you select this checkbox, the system imports only the delta file instead of the full file.
· The Bank Key in Type 4 parameter controls which data (fields) is used from the file as the bank key if the bank key type 4 (assigned externally) is set for the relevant country in the country-specific checks
· SEPA mode (IBAN BIC) check box: Select this checkbox if you plan to transfer funds to a country as a SEPA payment only.
· Use IBAN Country Code checkbox: If you select this checkbox, the system uses the IBAN country code for the bank assignment.
· Branch Code XXX for HQ checkbox: If you select this checkbox, the system uses the dummy branch code XXX from the file to increase the 8-character BIC to the full 11 characters, for example: NDEASESSXXX. If you do not select this checkbox, the system transfers the BIC without the branch identifier, for example, NDEASESS. This parameter does not affect the full 11-character BICs. These are always transferred in full, for example, NDEASESSA21. You can use this parameter, for example, to also import a national bank directory where the dummy ID XXX is not used. This avoids duplicate entries where one has the XXX ID and the other does not.
· Mark for Deletion checkbox: If you select this checkbox, the system flags banks for deletion that are no longer valid in the SAP system.
· For Own Data Records Only (BDE) checkbox: If you select this checkbox, you restrict the quantity of banks flagged for deletion to those that were created with this program and file format.
	The Import and Export Bank Accounts screen displays.
	



[bookmark: unique_29][bookmark: _Toc51268827]Fields Enhancement for Bank Account Master Data
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Prerequisite
This function only applies to extensive system.
Purpose
A BADI is provided to implement definition of custom fields and its default value. You can use this function to define your field and set its default value through BADI coding, implementation tutorial is attached on the online document help of Cash & Liquidity Management.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log on
	Log onto the SAP Fiori launchpad as Administrator.
	
	

	2
	Access the SAP Fiori app
	Open Custom Fields and Logic (F1481).
	
	

	3
	Create a Custom Field
	On the Custom Fields tab, choose Create
Make the following entries and choose Create.
Business Context：Bank Account Master Data
Label：Custom field
Identifier：YY1_ custom field
Tooltip：custom field
Type：Select one type
Choose Create and Edit.
	
	

	4
	Enable Field Usage
	Choose UIs and Reports tab.
Choose Enable Usage.
	
	

	5
	Publish Fields
	Log on to the SAP Fiori launchpad as a Cash Management Specialist.
You need to assign Administrator Role to User Cash Management Specialist, otherwise you won't see Adapt UI option.
Open Manage Bank Accounts (F1366A).
Choose the (>) button to go into detail of a bank account.
Choose Cash_Specialist Icon on the upper right of the screen.
Choose Adapt UI.
Select one area
Choose Add: Field.
Select the checkbox of the newly added field.
Choose OK.
Choose Publish.
Choose Save&Exit.
	
	

	6
	Create a custom logic
	Choose the Custom Logic tab.
Choose Create.
Make the following entries and choose Create.
Business Context: Bank Account Master Data
BAdI Description: Field Status Control for Bank Accounts in Workflow Processes
Implementation Description: Enable edition in workflow.
Implementation ID: YY1_ WF_TEST
Choose Create.
Input BADI code which is used to define default value of the field(s).
For more information, you can refer to the tutorial video attached on the online help of Cash and Liquidity Management > Bank Relationship Management > Apps > Manage Bank Accounts > App Extensibility: Manage Bank Accounts .
Choose Publish.
	
	


[bookmark: unique_36][bookmark: _Toc51268828]Maintain Bank Chain
Bank chains are used to make payments that are transferred through up to three intermediary banks before going to the beneficiary bank.
Before the implementation of this function, when making a payment to a business partner abroad, you had to specify your house bank and the business partner’s bank when processing payments. These two banks represented the start and end of the payment cycle and it was down to the house bank to determine via which banks the payment should be made. Using the bank chain function, you can now specify this bank chain yourself, leading to faster payment transaction processing and considerable cost savings through reduced bank charges.
For each payment, the payment program can determine a combination of intermediary banks that you previously defined. The order of the banks in the bank chain can depend on the following factors:
1. House bank
· Supplier’s bank details
· Customer’s bank details
· Currency
· Payment method supplement
The system uses bank chains only for payments with payment methods that require a bank chain.
Bank chains are transferred each time a payment medium is created. The following formats are supported in this process:
1. S.W.I.F.T MT101
· S.W.I.F.T MT103
[bookmark: unique_30][bookmark: _Toc51268829]Create Bank Chain
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Prerequisite
The recipient’s bank key and recipient’s bank account number of the bank chain is maintained in the business partner not Manage Bank Account app. The sender’s bank key is maintained in Manage Bank Account app, and the sender’s bank account is the house bank account you maintained for the bank key. Make sure you have created the business partner and maintained corresponding bank key and bank account before testing.
Purpose
The purpose of this step is to create a bank chain.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log on
	Log on to the SAP Fiori launchpad as an Accounts Payable Accountant.
	
	

	2
	Access the SAP Fiori app
	Open Manage Bank Chains (F4004).
	
	

	3
	Create Bank Chain
	Choose Create.
	The Create Bank screen displays.
	

	4
	Enter Bank Data
	Make the following entries:
Business Partner: <Select one business partner>
Country Key of Sender Bank: DE
Bank Key of Sender Bank: 50070010
Account Number at Sender Bank: 1133698
Currency: EUR
	
	

	5
	Create Intermediary Banks
	Choose Items tab.
Choose Add.
	
	

	6
	Enter Intermediary Bank Data
	Make the following entries and choose Save.
Type of Bank in Bank Chain: for example, 2 (Intermediary bank)
Country Key of a Correspondent Bank: DE
Bank Key of a Correspondent Bank: 82080000
Account Number of a Correspondent Bank: 2580061
	
	


[bookmark: unique_31][bookmark: _Toc51268830]Change Bank Chain
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
The purpose of this step is to change a bank chain.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log on
	Log on to the SAP Fiori launchpad as a Accounts Payable Accountant.
	
	

	2
	Access the SAP Fiori app
	Open Manage Bank Chains (F4004).
	
	

	3
	Edit Bank Chain
	Input the filter and choose Go
Choose the triangle button of the bank chain
	
	

	4
	Start to Edit
	Choose Edit. Modify fields to your requirements.
	
	

	5
	Save
	Choose Save.
	
	



[bookmark: unique_32][bookmark: _Toc51268831]Delete Bank Chain
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
The purpose of this step is to delete a bank chain.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log on
	Log on to the SAP Fiori launchpad as a Accounts Payable Accountant.
	
	

	2
	Access the SAP Fiori app
	Open Manage Bank Chains (F4004).
	
	

	3
	Delete Bank Chain (Option 1)
	Input the filter and choose Go
Select the check box of the bank chain.
Choose Delete.
Choose Delete.
	The selected object has been deleted
	


[bookmark: unique_33][bookmark: _Toc51268832]Check Bank Chain Information In Business Partner (Optional)
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
The receiver’s bank account is associated with the business partner, you can find the bank chain information via business partner.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log on
	Log on to the SAP Fiori launchpad as a Accounts Payable Accountant.
	
	

	2
	Access the SAP Fiori app
	Open Maintain Business Partner (BP).
	
	

	3
	Search Business Partner
	Choose Open BP.
Press F4.
Choose Partner by bank details tab.
If you can’t find Partner by bank detail tab, you can click more button, scroll down to select this tab.
Make the following entries.
Bank Key: for example, 82080000.
Bank Account: for example, 2580061
Choose Find.
Choose the line item and press Enter.
Choose Enter.
	The Create Bank screen displays.
	

	4
	Recipient Bank Chain
	Make the following entry:
Display in BP role: Financial Services BP
Choose Payment Transactions Tab.
Choose the radio button of one line item in the Bank Details.
Choose Recpnt Bank Chains.
Sender Bank Chains function is not activated in this version.
	The selection area displays the sender’s bank information.
	

	5
	Bank Chain Assignment
	Choose the check box of one line item in the selection area.
Double click Bank Chain Assignment.
	Bank chain assignment area displays the intermediary bank information.
	


[bookmark: unique_34][bookmark: _Toc51268833]Schedule Delete Bank Chain Jobs
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
The purpose of this step is to schedule jobs to delete bank chain.
Prerequisite
Schedule Delete Bank Chain Jobs is only used for deleting unused bank chain, which means the recipient bank account of the bank chain are no longer related to any business partner. In addition, the intermediary banks data should exist before using this job..
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log on
	Log on to the SAP Fiori launchpad as an Accounts Payable Accountant.
	
	

	2
	Access the SAP Fiori app
	Open Schedule Bank Chain Jobs (F4503).
	
	

	3
	Start Schedule Delete Bank Chain Jobs
	Choose New.
	The New Job screen displays.
	

	4
	Enter Job Parameters
	Make the following entries:
Job Template: Delete Bank Chains
Job Name: Delete Bank Chains
Start Immediately: <Select>
Bank Key Recipient: for example, 82080000
Bank Key Sender: for example, 50070010
Bank Account/IBAN Recip.: 2580061
Bank Ctry Recipient: DE
Bank Ctry Sender: DE
	
	

	5
	Schedule Delete Bank Chain Jobs
	Choose Schedule.
	
	




Typographic Conventions
	Type Style
	Description

	Example
	Words or characters quoted from the screen. These include field names, screen titles, pushbuttons labels, menu names, menu paths, and menu options.
Textual cross-references to other documents.

	Example
	Emphasized words or expressions.

	EXAMPLE
	Technical names of system objects. These include report names, program names, transaction codes, table names, and key concepts of a programming language when they are surrounded by body text, for example, SELECT and INCLUDE.

	Example
	Output on the screen. This includes file and directory names and their paths, messages, names of variables and parameters, source text, and names of installation, upgrade and database tools.

	Example
	Exact user entry. These are words or characters that you enter in the system exactly as they appear in the documentation.

	<Example>
	Variable user entry. Angle brackets indicate that you replace these words and characters with appropriate entries to make entries in the system.

	EXAMPLE
	Keys on the keyboard, for example, F2 or ENTER.
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